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Getting started
- AwaNNe

See the Important Safety and Product Information guide in the product box for product warnings and other
important information.

Update the maps and software on your device (Map and Software Updates, page 40).

Mount the device in your vehicle and connect it to power (Mounting and powering the CamperVan device in
your vehicle, page 2).

+ Acquire GPS signals (Acquiring GPS signals, page 3).

Adjust the volume (Adjusting the volume, page 3) and display brightness (Adjusting the screen brightness,
page 4).
Navigate to your destination (Starting a route, page 13).

CamperVan device overview

power key
USB power and data port
Map and data memory card slot

Microphone for voice command or hands-free calling

® O
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Mounting and powering the CamperVan device in your vehicle

This product contains a lithium-ion battery. To prevent the possibility of personal injury or product damage
caused by battery exposure to extreme heat, store the device out of direct sunlight.

Before you use your device on battery power, you should charge it.

1
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Plug the vehicle power cable (D into the USB port on the device.

Press the mount @ onto the suction cup @ until it snaps into place.

Press the suction cup to the windscreen, and flip the lever @ back toward the windscreen.
Fit the tab on the top of the mount into the slot on the back of the device.

Press the bottom of the mount into the device until it clicks.

Plug the other end of the vehicle power cable into a power outlet in your vehicle.

Turning the device on or off

To turn the device on, press the power key @ or connect the device to power.

To put the device in power saving mode, press the power key while the device is on.

While in power saving mode, the screen is off and the device uses very little power, but it can wake instantly
for use.

TIP: you can charge your device faster by putting it in power saving mode while charging the battery.
To turn off the device completely, hold the power key until a prompt appears on the screen, then select Off.

The prompt appears after five seconds. If you release the power key before the prompt appears, the device
enters power saving mode.
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Acquiring GPS signals

When you turn on your navigation device, the GPS receiver must collect satellite data and establish the current
location. The time required to acquire satellite signals varies based on several factors, including how far you
are from the location where you last used your navigation device, whether you have a clear view of the sky, and
how long it has been since you last used your navigation device. The first time you turn on your navigation
device, it may take several minutes to acquire satellite signals.

1 Turn on the device.
2 Wait while the device locates satellites.
3 If necessary, go to an open area away from tall buildings and trees.

alllin the status bar indicates the satellite signal strength. When at least half of the bars are filled, the device
is ready for navigation.

Status bar icons

The status bar is located at the top of the main menu. The status bar icons display information about features
on the device. You can select some icons to change settings or view additional information.

II GPS signal status. Hold to view GPS accuracy and acquired satellite information (Viewing GPS
ail signal status, page 46).

Bluetooth® technology status. Select to view the Bluetooth settings (Wireless network settings,
page 38).

>%

)

Wi-Fi signal strength. Select to change the Wi-Fi settings (Wireless network settings, page 38).
Connected to hands-free calling. Select to place a phone call (Hands-free calling, page 27).
Current time. Select to set the time (Setting the Time, page 39).

Battery charge level.

@ [ © ¢ v
[
o

Garmin Drive™ app connection status (Pairing with Your Smartphone, page 24).

5 3 oc Temperature. Select to view the weather forecast (Viewing the weather forecast, page 31).

Using the on-screen buttons

On-screen buttons allow you to navigate the pages, menus and menu options on your device.
- Select € to return to the previous menu screen.

+ Hold € to quickly return to the main menu.

+ Select A\ or W to scroll through lists or menus.

+ Hold &\ or W to scroll faster.

- Select = to see a context-based menu of options for the current screen.

Adjusting the volume
1 Select {).
2 Select an option:
+ Use the slider bar to adjust the volume.
+ Select NL to mute the device.
+ Select a tick box to enable or disable additional sound options.
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Enabling automatic volume

Your device can increase or decrease the volume automatically based on the level of background noise.
1 Select {).

2 Select Automatic Volume.

Using the audio mixer

You can use the audio mixer to set the volume levels for different audio types, such as navigation prompts or
phone calls. The level for each audio type is a percentage of the master volume.

1 Select {).
2 Select Mixer.
3 Use the sliders to adjust the volume for each audio type.

Adjusting the screen brightness
1 Select ¥ > Display > Brightness.
2 Use the slider bar to adjust the brightness.

Driver awareness features and alerts

/\ CAUTION
The driver alerts and speed limit features are for information only. They do not replace your responsibility to
abide by all posted speed limit signs and to use safe driving judgement at all times. Garmin® is not responsible
for any traffic fines or citations that you receive for failing to follow all applicable traffic laws and signs.

Your device provides features that can help encourage safer driving and increase efficiency, even when you are
driving in a familiar area. The device plays an audible tone or message and displays information for each alert.
You can enable or disable the audible tone for some types of driver alerts. Not all alerts are available in all
areas.

Schools: the device plays a tone and displays the speed limit (if available) for an upcoming school or school
zone.

Speed limit exceeded: the device plays a tone and displays a red border on the speed limit icon when you
exceed the posted speed limit for the current road.

Speed limit reduced: the device plays a tone and displays the upcoming speed limit so you can be prepared to
adjust your speed.

Wrong way on a one-way street: the device plays a message and displays a full-screen warning if you travel the
wrong way on a one-way street. The edges of the screen appear red and an alert remains at the top of the
screen until you leave the one-way street or correct your direction of travel.

Level crossing: the device plays a tone to indicate an upcoming level crossing.
Animal crossing: the device plays a tone to indicate an upcoming animal crossing area.
Bends: the device plays a tone to indicate a bend in the road.

Slower traffic: the device plays a tone to indicate slower traffic when you approach slower traffic at a higher
speed. Your device must be receiving traffic information to use this feature (Traffic, page 28).

Construction zone: the device plays a tone and displays a message when you approach a construction zone.
Lane closure: the device plays a tone and displays a message when you approach a lane closure.

Break planning: the device plays a tone and suggests upcoming rest stops after you have been driving for a
long time.

Enabling or Disabling Driver Alerts

You can enable or disable several types of driver alerts.
1 Select ¥k > Driver Assistance > Driver Alerts.

2 Select or clear the tick box next to each alert.
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Red light and speed cameras

NOTICE

Garmin is not responsible for the accuracy of or the consequences of using a red light or speed camera
database.

NOTE: this feature is not available for all regions or product models.

Information about red light and speed camera locations is available in some areas for some product models.
The device alerts you when you approach a reported speed or red light camera.

+ In some areas, your device can receive live red light and speed camera data while connected to a
smartphone running the Garmin Drive app.

+ You can use the Garmin Express” software (garmin.com/express) to update the camera database stored on
your device. You should update your device frequently to receive the most up-to-date camera information.

Finding and saving locations

The maps loaded in your device contain locations, such as restaurants, hotels, vehicle services, and detailed
street information. The Where To? menu helps you find your destination by providing several methods to
browse, search, and save this information.

From the main menu, select Where To?.

+ To quickly search all locations on your device, select Qsearch (Finding a location using the search bar,
page 5).

+ To find an address, select Address (Finding an address, page 6).

+ To browse or search pre-loaded points of interest by category, select Categories (Finding a location by
category, page 7).

« To search near a different town or area, select 9 next to the current search area (Changing the search area,
page 7).

- To view and edit your saved locations, select Favourites (Saving Locations, page 11).

+ To view locations you have recently selected from the search results, select History (Viewing history,
page 10).

+ To navigate to specific geographic coordinates, select Coordinates (Finding a location using coordinates,
page 10).

Finding a location using the search bar
You can use the search bar to search for locations by entering a category, brand name, address or town name.
1 Select Where To?.
2 Select Search in the search bar.
3 Enter all or part of the search term.
Suggested search terms appear below the search bar.
4 Select an option:
- To search for a type of business, enter a category name (for example, "cinemas").
+ To search for a business name, enter all or part of the name.
+ To search for an address near you, enter the house number and street name.
+ To search for an address in another town, enter the house number, street name, town and county.
+ To search for a town, enter the town and county.
+ To search for coordinates, enter latitude and longitude coordinates.
5 Select an option:
+ To search using a suggested search term, select the term.
+ To search using the text you entered, select Q.
6 |If necessary, select a location.
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Finding an address

NOTE: the order of the steps may change depending on the map data loaded on your device.

1 Select Where To?.

W N

Select Address.

a b~

Select the address.

Location Search Results

If necessary, select 9 to search near a different town or area.

Follow the on-screen instructions to enter address information.

The location search results appear in a list, with the nearest location at the top. Each numbered location also
appears on the map. You can scroll down to view more results.

20
©0
@Y
®=s
® 6o

®\ 1. Lush
| - Whitehall, SW1, LDN
Okm

i @lgOL
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v 2. Cool Britannia

35 Whitehall, SW1, LDN
Oxm NE |

3. CGX Accessories

Search

3
( . 51 Whitehall, SW1,LDN P
Okm SE l 15m

Select a location to view the option menu.

Select to view detailed information about the location.

Select to find parking areas near the location.

Select to view alternative routes to the location.

Select to create a route to the location using the Road Trip Routes feature (Starting a Route Using

the RoadTrip Routes Feature, page 13).

Select to start navigating to the location using the recommended route.
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Changing the search area

By default, the device searches for locations near your current location. You can also search other areas, such
as near your destination, near another city, or along your active route.

1 Select Where To?.
2 Select 9 next to the current search area @

— ¥ SW1, LDN I Search |
m Go Home Trendy Places
]_% Address a All Campgrounds

v c Saved Categories

( O] Recent ‘ Tripadvisor

3 Select a search area.
4 If necessary, follow the on-screen instructions to select a specific location.

The selected search area appears next to 9. When you search for a location using any of the options in the
Where To? menu, the device suggests locations near this area first.

Points of Interest

A point of interest is a place that you may find useful or interesting. Points of interest are organised by category
and can include popular travel destinations such as petrol stations, restaurants, hotels, and entertainment
venues.

Finding a location by category

1 Select Where To?.

2 Select a category or select Categories.
3 If necessary, select a subcategory.

4 Select a location.

Searching within a category

After you have performed a search for a point of interest, certain categories may display a Quick Search list that
displays the last four destinations you selected.

1 Select Where To? > Categories.
2 Select a category.
3 Select an option:
+ Select a destination from the quick search list on the right side of the screen.
The quick search list provides a list of recently found locations in the selected category.
+ Select a subcategory, if necessary, and select a destination.

Finding Campsites
Select Where To? > All Campsites.
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Finding Campsites with Amenities
You can search for motorhome parks and campsites based on the amenities available.
1 Select Where To?.

2 Select an motorhome parks and campgrounds search provider, such as ACSI, Campercontact or
iOverlander.

3 If necessary, select a category.
4 Select Search Filters, select one or more amenities and select Save.
5 Select alocation.

Finding ACSI™ campsites

NOTE: this feature is not available in all areas.

You can search for Auto Camper Service International (ACSI) campsites based on the amenities available.
1 Select Where To? > ACSI.

2 If necessary, select Search Filters, select one or more amenities and select Save.

3 Select a location.

Finding iOverlander™ points of interest

NOTICE

You are responsible for understanding and complying with any applicable regulations associated with
campsites and points of interest.

Your device includes iOverlander points of interest, which allow you to find points of interest useful for
overlanding, such as campsites, repair services and accommodation.

1 Select Where To? > iOverlander.
2 Select a category.
3 Select a location.

Finding Campercontact™ Campsites

NOTE: this feature is not available in all areas.

You can search for Campercontact campsites and motorhome parks based on the amenities available.
1 Select Where To? > Campercontact.

2 Select a category.

3 If necessary, select Search Filters, select one or more amenities and select Save.

4 Select a location.

Tripadvisor
Your device includes Tripadvisor points of interest and ratings. Tripadvisor ratings appear automatically in the
search results list for applicable points of interest. You can also search for nearby Tripadvisor points of interest
and sort by distance or popularity.
Finding Tripadvisor points of interest
1 Select Where To? > Tripadvisor.
2 Select a category.
3 If necessary, select a subcategory.
A list of nearby Tripadvisor points of interest for the category appears.
4 Select Sort Results to filter the displayed points of interest by distance or popularity (optional).
5 Select Q, and enter a search term (optional).
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Michelin’
Your device includes Michelin points of interest and ratings. Michelin ratings appear automatically in the search
results list for applicable points of interest. You can also search for nearby Michelin points of interest and sort
by distance or popularity.
Finding Michelin points of interest
1 Select Where To? > MICHELIN Green Guide.
2 Select a category.
3 If necessary, select a subcategory.
A list of nearby Michelin points of interest for the category appears.
4 Select Search Filters to filter the displayed points of interest by distance or popularity (optional).
5 Select Q, and enter a search term (optional).

Trendy Places

The Trendy Places search feature includes both Tripadvisor and Michelin points of interest and ratings,
providing a comprehensive list of attractions. You can filter the search results by categories, ratings and
distance from the route.

Performing a Trendy Places Search

1 Select Trendy Places.

2 Select Search Filters to filter the displayed points of interest by category or rating (optional).

3 Select Q, and enter a search term (optional).

Navigating to points of interest within a venue
NOTE: this feature may not be available in all areas or for all product models.

You can create a route to a point of interest (POI) within a larger venue, such as a store in a shopping centre or
a specific terminal in an airport.

1 Select Where To? > Search.
2 Select an option:
- To search for the venue, enter the name or address of the venue, select Q, and go to step 3.
- To search for the POI, enter the name of the POI, select Q, and go to step 5.
3 Select the venue.
A list of categories appears below the venue, such as restaurants, car hire, or terminals.
4 Select a category.
5 Select the POI, and select Go!.
The device creates a route to the parking area or venue entrance closest to the POI. When you arrive at the
destination, a chequered flag indicates the recommended parking area. A labelled point indicates the location
of the POI within the venue.
Exploring a venue
NOTE: this feature may not be available in all areas or for all product models.
You can view a list of all points of interest located within each venue.
1 Select a venue.
2 Select @ > Explore this Venue.

Search tools
Search tools allow you to search for specific types of locations by responding to on-screen prompts.
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Finding a junction

You can search for a junction between two streets, motorways, or other roads.
1 Select Where To? > Junctions.

2 Follow the on-screen instructions to enter street information.

3 Select the junction.

Finding a location using coordinates

You can find a location using latitude and longitude coordinates.

1 Select Where To? > Coordinates.

2 |If necessary, select % and change the coordinate format or datum.
3 Enter the latitude and longitude coordinates.

4 Select Gol.

Parking

Your CamperVan device includes detailed parking data, which can help you find nearby parking based on the
likelihood of available parking spots, type of parking area, price, or accepted payment methods.

NOTE: detailed parking data is not available in all areas or for all parking locations.

Finding Parking Near Your Current Location
1 Select Where To? > Categories > Parking.

2 Select Filter Parking, and select one or more categories to filter parking by availability, type, price, or
payment methods (optional).

NOTE: detailed parking data is not available in all areas or for all parking locations.
3 Select a parking location.
4 Select Go!.

Finding Parking Near a Specified Location

1 Select Where To?.
2 Search for a location.
3 From the location search results, select a location.
4 Select ®
A list of parking areas near the selected location appears.

5 Select Filter Parking, and select one or more categories to filter parking by availability, type, price or
payment methods (optional).

NOTE: detailed parking data is not available in all areas or for all parking locations.
6 Select a parking location.
7 Select Gol.

Understanding Parking Colours and Symbols

Parking locations that include detailed parking data are colour-coded to show the likelihood of finding parking.
Symbols indicate the type of parking available (street or car park), relative pricing information and payment

type.
You can view the legend for these colours and symbols on the device.
From the parking search results, select O.

Viewing history
Your device stores a history of the last 50 locations you have found.
Select Where To? > History.
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Clearing the list of recently found places
Select Where To? > History > = > Clear > Yes.

Viewing current location information

You can use the Where Am 1? page to view information about your current location. This feature is helpful if you
need to tell emergency personnel your location.

From the map, select the vehicle.

Finding emergency services and fuel
You can use the Where Am 1? page to find the nearest hospitals, police stations, and fuel stations.
1 From the map, select the vehicle.
2 Select Hospitals, Police Station, Petrol Stations or Roadside Assist..
NOTE: some service categories are not available in all areas.
A list of locations for the selected service appears, with the nearest locations at the top.
3 Select a location.
4 Select an option:
+ To navigate to the location, select Go!.
+ To view the phone number and other location details, select O

Getting directions to your current location

If you need to tell another person how to get to your current location, your device can give you a list of
directions.

1 From the map, select the vehicle.
2 Select = > Directions to Me.

3 Select a starting location.

4 Select Select.

Adding a shortcut

You can add shortcuts to the Where To? menu. A shortcut can point to a location, a category, or a search tool.
The Where To? menu can contain up to 36 shortcut icons.

1 Select Where To? > Personalise.

2 Select an item.

Removing a shortcut

1 Select Where To? > = > Remove Shortcut(s).
2 Select a shortcut to remove.

3 Select the shortcut again to confirm.

4 Select Done.

Saving Locations

Saving a location

1 Search for a location (Finding a location by category, page 7).
From the search results, select a location.

Select 0 > Save.

If necessary, enter a name, and select Done.

Select Save.
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Saving your current location

1 From the map, select the vehicle icon.
2 Select Save.

3 Enter a name and select Done.

Editing a favourite location

Select Where To? > Favourites.

If necessary, select a category.

Select a location.

Select €.

Select = > Edit.

Select an option:

+ Select Name.

+ Select Phone Number.

+ Select Categories to assign categories to the saved location.
+ Select Map Symbol to change the symbol used to mark the saved location on a map.
7 Edit the information.

8 Select Done.
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Assigning categories to a saved location

You can add custom categories to organise your saved locations.

NOTE: categories appear in the saved locations menu after you have saved more than 12 locations.
Select Where To? > Favourites.

Select a location.

Select o

Select = > Edit > Categories.

Enter one or more category names, separate by commas.

If necessary, select a suggested category.

Select Done.
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Deleting a favourite location

NOTE: deleted locations cannot be recovered.

1 Select Where To? > Favourites.

2 Select = > Delete.

3 Select the box next to the saved locations to delete and select Delete.
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Navigating to your destination

Routes
A route is a path from your current location to one or more destinations.

+ The device calculates a recommended route to your destination based on the preferences you set, including
the route calculation mode (Changing the route calculation mode, page 17) and avoidances (Avoiding
Delays, Tolls and Areas, page 18).

+ You can start navigating to your destination quickly using the recommended route, or you can select an
alternative route (Starting a route, page 13).

- If there are specific roads you need to use or avoid, you can customise the route (Shaping Your Route,
page 17).

+ You can add multiple destinations to a route (Adding a location to your route, page 17).

Starting a route
1 Select Where To?, and search for a location (Finding and saving locations, page 5).
2 Select a location.
3 Select an option:
+ To start navigating using the recommended route, select Go!.
+ To choose an alternative route, select V, and select a route.
Alternative routes appear to the right of the map.

- To edit the course of the route, select ¥ > Edit Route, and add shaping points to the route (Shaping Your
Route, page 17).

The device calculates a route to the location and guides you using voice prompts and information on the map
(Your route on the map, page 15). A preview of the major roads in your route appears at the edge of the map
for several seconds.

If you need to stop at additional destinations, you can add the locations to your route (Adding a location to your
route, page 17).

Starting a Route Using the RoadTrip Routes Feature

Your device can calculate routes that prefer bendy roads, hills and fewer motorways. This feature can provide a
more enjoyable drive but it may increase the time or distance to your destination.

Select Where To? > Categories.

If necessary, select a subcategory.

Select a location.

Select °§

Use the slider to increase or decrease the length of your route.
If necessary, select ~ to add shaping points to your route.
Select Go!.
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Starting a route by using the map

You can start a route by selecting a location from the map.

1 Select View Map.

2 Drag and zoom the map to display the area to search.

3 If necessary, select Q to filter the displayed points of interest by category.
Location markers (m or a blue dot) appear on the map.

4 Select an option:
+ Select a location marker.
+ Select a point, such as a street, junction or address location.

5 Select Gol.

Going home

The first time you start a route home, the device prompts you to enter your home location.
1 Select Where To? > Go Home.

2 If necessary, enter your home location.

Editing your home location
1 Select Where To? > = > Set Home Location.
2 Enter your home location.
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Your route on the map

As you travel, the device guides you to your destination using voice prompts and information on the map.
Instructions for your next turn or exit, or other actions appear across the top of the map.

@ 250. Aldwych

Next action in the route. Indicates the next turn, exit, or other action and the lane in which you should
travel, if available.

Distance to the next action.
Name of the street or exit associated with the next action.
Route highlighted on the map.

Next action in the route. Arrows on the map indicate the location of upcoming actions.

Vebhicle speed.

TIP: you can touch this field to open the trip information page (Viewing the trip information page,
page 22).

Name of the road on which you are travelling.

Estimated arrival time.
TIP: you can touch this field to change the information it shows (Changing the map data field, page 23).

©@Q @ @® G 0.

Map tools. Provides tools to show you more information about your route and surroundings.

Active lane guidance

As you approach some turns, exits, or interchanges in your route, a detailed simulation of the road appears
beside the map, if available. A coloured line (1) indicates the proper lane for the turn.

Navigating to your destination
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Viewing turns and directions
While navigating a route, you can view upcoming turns, lane changes, or other directions for your route.
1 From the map, select an option:

+ To view upcoming turns and directions as you navigate, select = > Turns.

The map tool displays the next several turns or directions beside the map. The list updates automatically
as you navigate the route.

+ To view the complete list of turns and directions for the entire route, select the text bar at the top of the
map.
2 Select a turn or direction (optional).

Detailed information appears. An image of the junction may appear for junctions on major roads, if
available.

Viewing the Entire Route on the Map
1 While navigating a route, select anywhere on the map.
2 Select :,:”:.

Arriving at your destination
When you approach your destination, the device provides information to help you complete your route.

- B indicates the location of your destination on the map, and a voice prompt announces you are approaching
your destination.

+ When you approach some destinations, the device automatically suggests parking areas. You can select
More to view a full list of suggested parking areas (Parking Near Your Destination, page 16).

* When you stop at your destination, the device automatically ends the route. If the device does not detect
your arrival automatically, you can select = > Stop to end your route.

Parking Near Your Destination

Your device can help you find a parking spot near your destination. When you approach some destinations, the
device automatically suggests parking areas.

1 Select an option:
When the device suggests parking, select More to see all suggested parking areas.
NOTE: when you select a suggested parking area, the device automatically updates your route.

If the device does not suggest parking locations, select Where To? > Categories > Parking, and select 9
My Destination.

2 Select Filter Parking, and select one or more categories to filter parking by availability, type, price or
payment methods (optional).

NOTE: detailed parking data is not available in all areas or for all parking locations.
3 Select a parking location and select Go!.
The device guides you to the parking area.
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Changing Your Active Route

Adding a location to your route
Before you can add a location to your route, you must be navigating a route (Starting a route, page 13).

You can add locations to the middle or end of your route. For example, you can add a petrol station as the next
destination in your route.

TIP: to create complex routes with multiple destinations or scheduled stops, you can use the route planner to
plan, schedule and save a route (Planning a Route, page 32).

1 From the map, select ( > Where To?.

Search for a location (Finding and saving locations, page 5).

Select a location.

Select Go!.

Select an option:

+ To add the location as the next destination in your route, select Add As Next Stop.

+ To add the location to the end of your route, select Add As Last Stop.

+ To add the location and edit the order of destinations in your route, select Add to Active Route.

The device re-calculates the route to include the added location and guides you to the destinations in order.
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Shaping Your Route
Before you can shape your route, you must start a route (Starting a route, page 13).

You can manually shape your route to change its course. This allows you to direct the route to use a certain
road or go through a certain area without adding a destination to the route.

1 Select anywhere on the map.
2 Select Shape Route.
TIP: you can select o= t0 zoom in on the map and select a more precise location.
The device enters route-shaping mode and recalculates the route to travel through the selected location.
3 Select Gol.
4 If necessary, select an option:
+ To add more shaping points to the route, select additional locations on the map.
+ To remove a shaping point, select the shaping point and select Remove.

Taking a detour

You can take a detour for a specified distance along your route or detour around specific roads. This is useful if
you encounter construction zones, closed roads or poor road conditions.

1 From the map, select = > Edit Route.
2 Select an option:
To re-route for a specific distance, select Detour by Distance.
+ To detour around a specific road on the route, select Detour by Road.

Changing the route calculation mode

1 Select 'Q' > Navigation > Calculation Mode.

2 Select an option:
+ Select Faster Time to calculate routes on streets that are faster to drive but can be longer in distance.
+ Select Straight Line to calculate off-road, point-to-point routes in a straight line.

Stopping the route

From the map, select = > Stop.

Navigating to your destination 17



Using Suggested Routes

Before you can use this feature, you must save at least one location and enable the travel history feature
(Device and privacy settings, page 39).

Using the myTrends” feature, your device predicts your destination based on your travel history, the day of the
week and the time of day. After you have driven to a favourite location several times, the location may appear in
the navigation bar on the map, along with the estimated time of travel and traffic information.

Select the navigation bar to view a suggested route to the location.
Avoiding Delays, Tolls and Areas

Avoiding traffic delays on your route

Before you can avoid traffic delays, you must be receiving traffic information (Receiving traffic data using your
smartphone, page 28).

By default, the device optimises your route to avoid traffic delays automatically. If you have disabled this option
in the traffic settings (Traffic Settings, page 38), you can view and avoid traffic delays manually.

1 While navigating a route, select = > Traffic.
2 Select Alternative Route, if available.
3 Select Go!.

Avoiding toll roads

Your device can avoid routing you through areas that require tolls, such as toll roads, toll bridges, or congestion
areas. The device may still include a toll area in your route if no other reasonable routes are available.

1 Select 'Q' > Navigation > Avoidances > Tolls and Fees.
2 Select Save.

Avoiding toll stickers

If the map data on your device contains detailed toll sticker information, you can avoid or allow roads that
require toll stickers for each country.

NOTE: this feature is not available in all areas.
1 Select 'Q' > Navigation > Toll Stickers.
2 Select a country.
3 Select an option:
To be asked each time before routing through an area that requires toll stickers, select Always Ask.
+ To always avoid roads that require toll stickers, select Avoid.
To always allow roads that require toll stickers, select Allow.
4 Select Save.

Avoiding road features
1 Select 'Q' > Navigation > Avoidances.
2 Select the road features to avoid on your routes and select Save.

Avoiding environmental zones
Your device can avoid areas with environmental or emissions restrictions that may apply to your vehicle.
1 Select 'Q' > Navigation > Environmental Zones.
2 Select an option:
+ To be asked each time before routing through an environmental zone, select Always Ask.
+ To always avoid environmental zones, select Avoid.
+ To always allow environmental zones, select Allow.
3 Select Save.
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Custom Avoidances

Custom avoidances allow you to select specific areas or sections of road to avoid. When the device calculates

a route, it avoids these areas and roads unless no other reasonable route is available.

Avoiding a road

1 Select 'Q' > Navigation > Custom Avoidances.

If necessary, select Add Avoidance.

Select Add Avoid Road.

Select the starting point of the section of road to avoid and select Next.
Select the ending point of the road section and select Next.

Select Done.
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Avoiding an area

1 Select 'Q' > Navigation > Custom Avoidances.

If necessary, select Add Avoidance.

Select Add Avoid Area.

Select the upper left corner of the area to avoid and select Next.Next
Select the lower right corner of the area to avoid and select Next.Next
The selected area is shaded on the map.

6 Select Done.
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Disabling a custom avoidance

You can disable a custom avoidance without deleting it.
1 Select 'Q' > Navigation > Custom Avoidances.

2 Select a created avoidance.

3 Select = > Disable.

Deleting custom avoidances
1 Select 'Q' > Navigation > Custom Avoidances > ﬁ
2 Select an option:
+ To delete all custom avoidances, select Select All > Delete.

+ To delete one custom avoidance, select the avoidance and select Delete.

Navigating off road

If you are not following roadways as you navigate, you can use Off Road mode.

1 Select 'Q' > Navigation.
2 Select Calculation Mode > Straight Line > Save.
The next route will be calculated as a straight line to the location.

Navigating to your destination
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Using the Map
You can use the map to navigate a route (Your route on the map, page 15) or to view a map of your
surroundings when no route is active.
1 Select View Map.
2 Select anywhere on the map.
3 Select an option:
+ Drag the map to pan left, right, up, or down.
To zoom in or out, select + or mmm
+ To switch between North Up and 3-D views, select A
To open the route planner, select it (Route Planner, page 32).
+ To filter the displayed points of interest by category, select Q.
To start a route, select a location on the map and select Go! (Starting a route by using the map, page 14).

Map Tools

Map tools provide quick access to information and device functions while you view the map. When you activate
a map tool, it appears in a panel at the edge of the map.

Stop: stops navigation of the active route.

Edit Route: allows you to re-route or skip locations in your route (Changing Your Active Route, page 17).

Mute Navigation: mutes the device audio.

Towns Ahead: shows upcoming towns and services along your active route or along a highway (Towns Ahead,
page 21).

Up Ahead: shows upcoming locations along the route or the road on which you are travelling (Up ahead,
page 20).

Elevation: displays elevation changes ahead.

Traffic: displays traffic conditions along your route or in your area (Viewing upcoming traffic, page 22). This
feature is not available in all areas or for all device models.

Trip Data: displays customisable trip data, such as speed or mileage (Viewing trip data from the map,
page 21).
Turns: displays a list of upcoming turns in your route (Viewing turns and directions, page 16).

Phone: displays a list of recent phone calls from your connected phone, and displays in-call options while a
phone call is active (Using in-call options, page 27).

Weather: displays weather conditions for your area.
photolLive: displays live traffic cameras from your photoLive subscription (photoLive traffic cameras, page 34).

Report Safety Camera: allows you to report a speed or red light camera. This tool is available only when you
have speed or red light camera data on your device and you have an active connection to the Garmin Drive
app (Live services, traffic and smartphone features, page 23).

Viewing a map tool
1 From the map, select =.
2 Select a map tool.
The map tool appears in a panel at the edge of the map.
3 When you have finished using the map tool, select ) &

Up ahead

The Up Ahead tool provides information about upcoming locations along your route or the road on which you
are travelling. You can view upcoming points of interest by category, such as restaurants, fuel stations or
roadside services.

You can customise the categories that show in the Up Ahead tool.
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Viewing upcoming locations
1 From the map, select = > Up Ahead.
While you are travelling, the map tool shows the next location along your road or route.
2 Select an option:
+ If the map tool shows categories, select a category to view a list of nearby locations in that category.

+ If the map tool shows upcoming locations, select a location to view location details or start a route to the
location.

Customising the up ahead categories

You can change the location categories that appear in the Up Ahead tool.

1 From the map, select = > Up Ahead.

2 Select a category.

3 Select ‘\,

4 Select an option:
+ To move a category up or down in the list, select and drag the arrow next to the category name.
+ To change a category, select the category.

+ To create a custom category, select a category, select Custom Search, and enter the name of a business
or category.

5 Select Save.

Towns Ahead

While you are travelling on a highway or navigating a route that includes a highway, the Towns Ahead tool
provides information about upcoming towns along the highway. For each town, the map tool shows the
distance to the highway exit and the services available, similar to the information on highway road signs.

Viewing Upcoming Towns and Exit Services
1 From the map, select == > Towns Ahead.

While you are travelling along a highway or an active route, the map tool shows information about upcoming
towns and exits.

2 Select atown.

The device shows a list of points of interest located at the selected town exit, such as fuel stations, lodging
or restaurants.

3 Select a location, and select Go! to start navigating.
Trip information

Viewing trip data from the map
Before you can view trip data on the map, you must add the tool to the map tools menu.
From the map, select = > Trip Data.

Using the Map 21



Viewing Customised Trip Information on the Map

You can use the trip data map tool to show customised trip information on the map.
1 From the map, select = > Trip Data.

2 Select an option:

450m Vauxhall Bridge
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Moving Avg.

00:49

Moving

Select a data field in the trip data tool @ and select the information to show in the field.
Select the customisable map data field @ and select the information to show in the field.

Viewing the trip information page
The trip information page displays your speed and provides statistics about your trip.
From the map, select Speed.

Viewing the trip log

Your device keeps a trip log, which is a record of the path you have travelled.
1 Select &¥ > Map Display > Map Layers.

2 Select the Travel History tick box.

Resetting trip information
1 From the map, select Speed.
2 Select = > Reset Field(s).

3 Select an option:

When not navigating a route, select Select All to reset every data field on the first page except the
speedometer.

Select Reset Overall Data to reset the information on the trip computer.
Select Reset Max. Speed to reset the maximum speed.
Select Reset Trip B to reset the odometer.

Viewing upcoming traffic

NOTICE

Garmin is not responsible for the accuracy or timeliness of the traffic information.

Before you can use this feature, your device must be receiving traffic data (Traffic, page 28).
You can view traffic incidents coming up along your route or along the road on which you are travelling.
1 While navigating a route, select = > Traffic.
The nearest upcoming traffic incident appears in a panel on the right side of the map.
2 Select the traffic incident to view additional details.
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Viewing traffic on the map

The traffic map shows colour-coded traffic flow and delays on nearby roads.
1 From the main menu, select == > Traffic.

2 If necessary, select = > Legend to view the legend for the traffic map.

Searching for traffic incidents

1 From the main menu, select == > Traffic.

2 Select = > Incidents.

3 Select an item in the list.

4 If there is more than one incident, use the arrows to view additional incidents.

Customising the map

Customising the map layers

You can customise which data appears on the map, such as icons for points of interest and road conditions.
1 Select 'Q' > Map Display > Map Layers.

2 Select the tick box next to each layer you want to show on the map.

Changing the map data field

1 From the map, select a data field.
NOTE: you cannot customise Speed.

2 Select a type of data to display.

Changing the map perspective

1 Select £¥ > Map Display > Driving Map View.

2 Select an option:
Select Track Up to display the map in two dimensions (2-D), with your direction of travel at the top.
Select North Up to display the map in 2-D with North at the top.
Select 3-D to display the map in three dimensions.

Live services, traffic and smartphone features

The Garmin Drive app allows your device to receive smart notifications and live information, such as live traffic
data and weather information.

Live traffic data: sends real-time traffic data to your device, such as traffic incidents and delays, construction
zones and road closings (Traffic, page 28).

Weather information: sends real-time weather forecasts, road conditions and weather radar to your device
(Viewing the weather forecast, page 31).

Smart Notifications: displays phone notifications and messages on your device. This feature is not available
for all languages.

Hands-Free calling: allows you to make and receive phone calls using your device, and allows you to use the
device as a hands-free speaker phone.

Send locations to device: allows you to send locations from your smartphone to your navigation device.
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Pairing with Your Smartphone

You can pair your CamperVan device with your smartphone and the Garmin Drive app to enable additional
features and access live information (Live services, traffic and smartphone features, page 23) .

1 From the app store on your smartphone, install the Garmin Drive app.

2 Turn on your CamperVan device and place the device and your smartphone within 3 m (10 ft.) of each other.
3 On your phone, open the Garmin Drive app.
4

Follow the on-screen instructions to sign in to a Garmin account and complete the pairing and setup
process.

The main app dashboard appears. After the devices are paired, they connect automatically when they are
turned on and within range.

Disabling Bluetooth features (Android™)

By default, all compatible Bluetooth features are enabled when you pair your phone. You can disable specific
Bluetooth features and remain connected to the other features.

1 Select 'Q' > Wireless Networks.
2 Select an option:
« To disable all Bluetooth features, clear the Bluetooth tick box.
+ To disable only hands-free calling, select the phone name and clear the Phone calls tick box.

Showing or hiding app notifications (Android)

You can use the Garmin Drive app to customise which types of smartphone notifications appear on your
CamperVan device.

1 On your phone, open the Garmin Drive app.
2 Select £F > Smart Notifications.
A list of smartphone app categories appears.
3 Select a category to enable or disable notifications for that type of app.

Disabling Bluetooth features (iPhone)

By default, all compatible Bluetooth features are enabled when you pair your phone. You can disable specific
Bluetooth features and remain connected to the other features.

1 Select 'Q > Wireless Networks.

2 To disable Garmin Drive app data and smartphone notifications, select Smartphone services and clear the
Smartphone services check box.

TIP: GF and [T appear coloured when the services are active.

Showing or hiding notification categories (iPhone)
You can filter the notifications shown on your device by showing or hiding categories.
1 Select 'Q' > Wireless Networks.
2 Select Smartphone services.
TIP: [T appears coloured when the services are active.
3 Select Smart Notifications.
4 Select the check box next to each notification to show.
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Bluetooth Feature status icons

Status icons appear in the Bluetooth settings next to each paired device.
Select 'Q' > Wireless Networks.

+ Agreyicon indicates the feature is disabled or disconnected for that device.

« A coloured icon indicates the feature is connected and active for that device.

\ Hands-free calling
LT Smart notifications
@J: Garmin Drive features and services

Smart Notifications

While your device is connected to the Garmin Drive app, you can view notifications from your smartphone on
your CamperVan device, such as text messages, incoming calls, and calendar appointments.

NOTE: you may need to wait a few minutes to receive notifications on your navigation device after it connects
to the Garmin Drive app. LT appears coloured in the Bluetooth settings when smart notifications are connected

and active (Bluetooth Feature status icons, page 25).

Receiving notifications

Do not read or reply to notifications while driving. If you do so, you could become distracted by the display,

which could lead to an accident causing serious personal injury or death.

Before you can use this feature, your device must be connected to a supported phone running the Garmin Drive

app (Live services, traffic and smartphone features, page 23).

From most pages, a pop-up appears when the device receives a notification from your smartphone. If the
device is moving, you must verify you are a passenger and not the driver before you can view notifications.

NOTE: if you are viewing the map, notifications appear in a map tool.
+ Toignore a notification, select OK.
The pop-up closes, but the notification remains active on your phone.
+ To view a natification, select View.
+ To listen to the notification, select View > Play.

The device reads the notification using text-to-speech technology. This feature is not available for all

languages.

+ To perform additional actions, such as dismissing the notification from your phone, select View, and select

an option.

NOTE: additional actions are available for only some notification types and must be supported by the app

generating the notification.

Live services, traffic and smartphone features
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Receiving notifications while viewing the map

Do not read or reply to notifications while driving. If you do so, you could become distracted by the display,
which could lead to an accident causing serious personal injury or death.

Before you can use this feature, your device must be connected to a supported phone running the Garmin Drive
app (Live services, traffic and smartphone features, page 23).

When you are viewing the map, new notifications appear in a map tool at the edge of the screen. If the device is
moving, you must verify you are a passenger and not the driver before you can view notifications.

+ Toignore a notification, select K or wait for the pop-up to expire.
The pop-up closes, but the notification remains active on your phone.

+ To view a notification, select the notification text.

+ To listen to the notification, select }

The device reads the notification using text-to-speech technology. This feature is not available for all
languages.

+ To listen to the notification using a voice command, say Play Message.

NOTE: this option is available only when the selected language supports the voice command feature and &
appears in the map tool.

Viewing the list of notifications
You can view a list of all active notifications.
1 Select == > Smart Notifications.
The list of notifications appears. Unread notifications appear black, and previously read notifications appear
grey.
2 Select an option:
+ To view a notification, select the notification description.
« To listen to a notification, select }

The device reads the notification using text-to-speech technology. This feature is not available for all
languages.

Going to an address or location using the Garmin Drive app

You can use the Garmin Drive app to search for an address, business or point of interest and send it to your
CamperVan device for navigation.

1 From the Garmin Drive app, select Where To?.
2 Select an option:
+ To search for an address near you, enter the house number and street name.
+ To search for an address in another town, enter the house number, street name, town and county.
+ To search for a business name, enter all or part of the name.
+ To search for a town, enter the town and county.
As you type, suggestions appear below the search field.
3 Select a suggested search result.
The app displays the location on a map.
4 Select Gol! to start a route.

The CamperVan device starts navigating to the selected location and the location is added to your recent
searches in the Where To? menu.
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Hands-free calling

NOTE: while most phones are supported and can be used, it cannot be guaranteed that a particular phone can
be used. All features may not be available for your phone.

Using Bluetooth wireless technology, your device can connect to your mobile phone to become a hands-free
device (Live services, traffic and smartphone features, page 23). While connected, you can place or receive calls
using your device.

Placing a call

Dialling a number

1 Select == > Phone > Dial.
2 Enter the number.

3 Select Dial.

Calling a contact in your phone book

Your phone book is loaded from your phone to the device each time your phone and the device connect. It may
take a few minutes for the phone book to be available. Some phones do not support this feature.

1 Select == > Phone > Phone Book.
2 Select a contact.
3 Select Call.

Calling a location

1 Select == > Phone > Browse Categories.
2 Select a point of interest.

3 Select Call.

Receiving a call
When you receive a call, select Answer or Ignore.

Using the call history

Your call history is loaded from your phone to the device each time your phone and the device connect. It may
take a few minutes for the call history to be available. Some phones do not support this feature.

1 Select 3@ > Phone > Call History.
2 Select a category.

A list of calls appears, with the most recent calls at the top.
3 Selectacall

Using in-call options
In-call options are available when you answer a call. Some options may not be compatible with your phone.

TIP: if you close the in-call options page, you can open it again by selecting U from any screen. You can also
select the caller from the map.

+ To set up a conference call, select Add Call.
+ To transfer audio to your phone, select Call in Progress on Navigator.

TIP: you can use this feature if you want to disconnect the Bluetooth connection and remain on the call, or if
you need privacy.

+ To use the dial pad, select Keypad.

TIP: you can use this feature to use automated systems, such as voice mail.
+ To mute the microphone, select Mute Navigation.
+ To hang up, select End Call.
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Saving a home phone number

TIP: after you save a home number, you can edit the home number by editing “Home” in your list of favourite
locations (Editing a favourite location, page 12).

1 Select == > Phone > = > Set Home Number.
2 Enter your phone number.
3 Select Done.

Calling home
Before you can call home, you must enter a phone number for your home location.
Select == > Phone > Call Home.

Deleting a paired phone

You can delete a paired phone to prevent it from automatically connecting to your device in the future.
1 Select ¥ > Wireless Networks.

2 Select the phone, then select Forget Device.

Traffic

Garmin is not responsible for the accuracy or timeliness of the traffic information.

Your device can provide information about traffic on the road ahead or on your route. You can set your device
to avoid traffic when calculating routes, and to find a new route to your destination if a large traffic delay
occurs on your active route (Traffic Settings, page 38). The traffic map allows you to browse the map for
traffic delays in your area.

To provide traffic information, your device must be receiving traffic data.

+ All product models can receive subscription-free traffic data using the Garmin Drive app (Receiving traffic
data using your smartphone, page 28).

+All product models can receive traffic data using an over-the-air traffic receiver accessory (Receiving traffic
data using a traffic receiver, page 29). Go to your product page at garmin.com to find and purchase a
compatible traffic receiver accessory.

Traffic data is not available in all areas. For information about traffic coverage areas, go to garmin.com/traffic.

Receiving traffic data using your smartphone

Your device can receive subscription-free traffic data while connected to a smartphone running the Garmin
Drive app.

1 Connect your device to the Garmin Drive app (Live services, traffic and smartphone features, page 23).
2 Onyour CamperVan device, select L£¥ > Traffic and verify the Traffic check box is selected.
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Receiving traffic data using a traffic receiver

NOTICE

Heated (metallised) windscreens could degrade the performance of the traffic receiver.

A traffic receiver receives traffic data from an over-the-air broadcast signal, where available. To receive over-
the-air traffic data, the device must be connected to vehicle power using a traffic-compatible power cable. A
traffic receiver is included with some product models (Traffic, page 28). If your product model does not include
a traffic receiver, you can go to your product page at garmin.com to find and purchase a compatible traffic
receiver cable accessory.

Traffic data is not available in all areas. For information about traffic coverage areas, go to garmin.com/traffic.

Connect the device to vehicle power using the traffic-compatible power cable (Mounting and powering the
CamperVan device in your vehicle, page 2).

If your product model includes traffic data, the vehicle power cable included with your device is traffic-
compatible. If you purchased a traffic receiver cable as an accessory, you should use the accessory cable to
connect the device to vehicle power.

When you are within a traffic coverage area, your device can display traffic information and help you avoid
traffic delays.

Traffic Receiver Subscriptions
A regional traffic data subscription is included with most traffic receivers. You can add subscriptions for
additional regions to your traffic receiver. For more information, go to garmin.com/traffic.
Viewing traffic subscriptions
Select 'Q' > Traffic > Subscriptions.

Adding a subscription

You can purchase traffic subscriptions for other regions or countries.

1 Select 'Q' > Traffic.

2 Select Subscriptions > +

3 Write down the FM traffic receiver unit ID.

4 Go to garmin.com/fmtraffic to purchase a subscription and get a 25-character code.

The traffic subscription code cannot be reused. You must obtain a new code each time you renew your
service. If you own multiple FM traffic receivers, you must obtain a new code for each receiver.

5 Select Next on the device.
6 Enter the code.
7 Select Done.

Enabling traffic

Before you can enable traffic, you must connect your device to a compatible traffic receiver cable (Receiving
traffic data using your smartphone, page 28).

You can enable or disable traffic data.
1 Select 'Q' > Traffic.
2 Select the Traffic tick box.

Viewing traffic on the map

The traffic map shows colour-coded traffic flow and delays on nearby roads.
1 From the main menu, select == > Traffic.

2 If necessary, select = > Legend to view the legend for the traffic map.
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Searching for traffic incidents

1 From the main menu, select == > Traffic.

2 Select = > Incidents.

3 Select anitem in the list.

4 If there is more than one incident, use the arrows to view additional incidents.

Voice Command

NOTE: voice command is not available for all languages and regions, and may not be available on all models.
NOTE: Voice Activated Navigation may not achieve desired performance when in a noisy environment.

Voice command allows you to use your device by saying words and commands. The voice command menu
provides voice prompts and a list of available commands.

Tlps for Speaking to the Device
+ Speak in a clear voice directed at the device.
Start each request with OK, Garmin.

Reduce background noise, such as voices or the radio, to help the device interpret your commands more
accurately.

Respond to voice prompts from the device as needed.
If you do not receive a useful response, try rephrasing your request.

If the device does not respond to your requests, verify that it is not placed near a speaker or air vent, which
can produce noise that interferes with the microphone.

Launching Garmin Voice-Activated Navigation

Garmin voice-activated navigation allows you to use requests spoken in plain language to search for locations
and addresses, start routes with turn-by-turn directions, place hands-free phone calls and more.

Say OK, Garmin, and make a spoken request.
For example, you can say phrases like these:
o OK Garmin, take me home.

o OK Garmin, where's the library?

Checking Your Arrival Time

While a route is active, you can say a phrase to check your estimated time of arrival at your destination.
Say OK Garmin, what time will we arrive?.

Placing a Phone Call Using Your Voice

You can use a voice command to call a contact from the phone book of your paired smartphone.
Say OK Garmin, call, and say the contact name.
For example, you can say OK Garmin, call Mum..

Changing Device Settings Using Your Voice

You can say phrases like these to set device settings to a value from 0 to 10.
OK Garmin, increase the volume.
OK Garmin, set the volume to 0.
OK Garmin, set the volume to 9.
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Viewing the Owner’s Manual on Your Device

You can view the complete owner's manual on the device screen in many languages.

1 Select == > Owner's Manual.
The owner's manual appears in the same language as the software text (Language and Keyboard Settings,
page 39).

2 Select Q to search the owner's manual (optional).

Viewing the weather forecast
Before you can use this feature, your device must be receiving weather data. You can connect your device to
the Garmin Drive app to receive weather data (Live services, traffic and smartphone features, page 23).
1 Select == > Weather.
The device shows the current weather conditions and a forecast for the next several days.
2 Select a day.
The detailed forecast for that day appears.

Viewing weather near a different town
1 Select == > Weather > Current Location.
2 Select an option:
+ To view weather for a favourite town, select a town in the list.
+ To add a favourite town, select Add Town, and enter a town name.

Viewing the weather radar

Before you can use this feature, your device must be connected to a supported phone running the Garmin Drive
app (Live services, traffic and smartphone features, page 23).

1 Select == > Weather Radar.
2 Select } to animate the radar map.

Viewing weather alerts

Before you can use this feature, your device must be connected to a supported phone running the Garmin Drive
app (Live services, traffic and smartphone features, page 23).

NOTE: this feature is not available in all areas.

While you are travelling with your device, weather alerts may appear on the map. You can also view a map of
weather alerts near your current location or near a selected town.

1 Select == > Weather.
2 If necessary, select a town.
3 Select = > Weather Alerts.

Checking road conditions

Before you can use this feature, your device must be connected to a supported phone running the Garmin Drive
app (Live services, traffic and smartphone features, page 23).

You can view weather-related road conditions for the roads in your area, on your route or in another town.
1 Select == > Weather.

2 |If necessary, select a town.

3 Select = > Road Conditions.
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BirdsEye Imagery

BirdsEye imagery provides downloadable, high-resolution map imagery, including detailed satellite imagery and
raster-based topographical maps. You can download BirdsEye Satellite Imagery directly to your device when it
is connected to a Wi-Fi” network.

Downloading BirdsEye Imagery

Before you can download BirdsEye imagery directly to your device, you must connect to a wireless network
(Connecting to a Wi-Fi Network, page 41).

1 Select == > BirdsEye Direct.
2 Select i
3 Select an option:
+ To download BirdsEye imagery files for a specific location or area, select Location and select a category.
NOTE: the location defaults to your current location.
+ To select an image quality option, select Detail.

+ To define the size of the area to be shown in the downloaded imagery files, select Height and enter a
distance from the selected location.

+ To select where to save the downloaded imagery, select Save to.
4 Select Download.
5 Enter a name for the downloaded imagery and select Done.

Route Planner

You can use the route planner to create and save a route, which you can navigate later. This can be useful for
planning a delivery route, a vacation, or a road trip. You can edit a saved route to further customise it, including
reordering locations, adding suggested attractions and adding shaping points.

You can also use the route planner to edit and save your active route.

Planning a Route

A route can include many locations and it must include at least a starting location and one destination. The
starting location is the location from which you plan to start your route. If you start navigating the route from a
different location, the device gives you the option to route to your starting location first. For a round trip, the
starting location and final destination can be the same.

1 Select Route Planner.
2 If necessary, select a calculation mode.
NOTE: the Faster Time mode is selected by default.
3 Select an option to choose a location for your starting point:
+ Select a location on the map.
- Select Q and search for a location (Finding a location using the search bar, page 5).
4 Repeat step 2 to add more locations.
NOTE: the last location you add is the destination.
5 After you have added all the necessary locations, select ]
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Editing and Reordering Locations in a Route

1 Select Route Planner.

Select a saved route.

Select List.

Select a location.

Select an option:

+ To move the location up or down, select & and drag the location to a new position in the route.
« To add a new location after the selected location, select @

« To remove the location, select ﬁ
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Discovering Attractions Along Your Route

You can perform a Trendy Places search to find interesting or popular attractions to add to your route.
1 While editing a route, select Q > Trendy Places.

2 |If necessary, select Search Filters to filter the displayed attractions by category or rating.

3 Select an attraction to view more information.

4 Select Select to add the attraction to your route.

Changing Routing Options for a Route
You can customise how the device calculates your route.
1 Select Route Planner.
2 Select a saved route.
3 Select .
4 Select an option:
To add shaping points to your route, select Shaping and select at least one location.
+ To change the calculation mode for the route, touch a route segment and select a calculation mode.

Navigating to a Saved Route

1 Select Route Planner.

2 Select a saved route.

3 Select Gol.

4 Select the first location to navigate to and select OK.

The device calculates a route from your current location to the selected location and then it guides you to
the remaining route destinations in order.

Editing and saving your active route
If a route is active, you can use the route planner to edit and save it.
1 Select Route Planner > My Active Route.
2 Edit your route using any of the route planner features.
The route recalculates each time you make a change.
3 Select Save to save your route, which you can navigate again later (optional).

Using the apps

33



TracBack’

Following your recent track

The TracBack feature records the most recent segment of your movement. You can retrace your recent track
back to a previous location.

1 Select == > TracBack.
Your recent track appears on the map.
2 Select Go!.

Saving Your Recent Track as a Route

You can save your recent track as a route, which you can navigate later using the route planner (Navigating to a
Saved Route, page 33).

1 Select TracBack.

Your recent track appears on the map.
2 Select ‘\, > Save as Route.
3 Enter a name and select Done.

photolLive traffic cameras

Before you can use this feature, your device must be connected to the Garmin Drive app (Live services, traffic
and smartphone features, page 23).

photoLive traffic cameras provide live images of traffic conditions on major roads and junctions.
The photoLive service is not available in all areas.

Viewing and Saving photoLive Traffic Cameras

You can view live images from nearby traffic cameras. You can also save traffic cameras for areas you travel
frequently.

1 Select == > photoLive.

2 Select Touch to Add

3 Selectaroad.

4 Select a traffic camera location.

A preview of the live image from the camera appears next to a map of the camera's location. You can select
the image preview to view the full-sized image.

5 Select Save to save the camera (optional).
A thumbnail image preview of the camera is added to the main screen of the photoLive app.

Viewing photoLive Traffic Cameras on the Map
The photoLive map tool shows traffic cameras from the road ahead of you.
1 From the map, select = > photoLive.

The device shows the live image from the nearest traffic camera on the road ahead, along with the distance
to the camera. When you pass the camera, the device loads the live image of the next camera on the road.

2 If no cameras are found for the road, select Find Cameras to view or save nearby traffic cameras (optional).

Saving a traffic camera
1 Select == > photoLive.

2 Select Touch to Add.

3 Select a traffic camera.
4 Select Save.
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Wireless Cameras
Your device can display the video feed from one or more connected wireless cameras.

Pairing the Camera with a Garmin Navigation Device

You can pair the camera with a compatible Garmin navigation device. For more information about compatible

Garmin devices, go to the product page at garmin.com/bc40.

1

6

Update your navigation device to the latest software.

Your device may not support the BC 40 camera without the latest software. For more information about
updating the software, see the owner's manual for your navigation device.

Install batteries in the camera.

The camera enters pairing mode automatically and the LED flashes blue while the camera is in pairing
mode. The camera remains in pairing mode for two minutes. If pairing mode expires, you can remove and
reinstall the batteries.

Bring the compatible Garmin navigation device outside your vehicle and within 1.5 m (5 ft.) of the camera
and turn on the navigation device.

The device detects your camera automatically and prompts you to pair with it.
Select Yes.

TIP: if the navigation device does not detect the camera automatically, you can select L¥ > Wireless
Cameras > Add New Camera to pair with it manually.

The device pairs with your camera.

Enter a name for the camera (optional).

You should use a descriptive name that clearly identifies the location of the camera.
Select Done.

Viewing the Wireless Camera

This device is intended to enhance situational awareness when used properly. If used improperly, you could
become distracted by the display, which could lead to an accident causing serious personal injury or death.
Always view the display at a glance when the vehicle is in motion to avoid becoming distracted.

From the home screen or the map, select .
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Aligning the Guidance Lines

For the best reference, the guidance lines should be aligned to reflect the outside edges of the vehicle. You
should align the guidance lines separately for each backup camera. When you change the camera angle, you
should immediately align the guidance lines again.

1 Position your vehicle with the driver's side closely aligned to a kerb, driveway or parking stall lines.

TIP: it can be helpful to position the vehicle in the centre of a parking stall and then pull forward into the next
stall. This allows you to use the parking stall lines at the rear of the vehicle as reference points for
alignment.

2 From the paired Garmin navigation device, select L¥ > Wireless Cameras.

Select the paired camera name and select Guidance Lines > Adjust Guidance Lines.

4 Use the arrows in the corners of the screen to move the ends of the white, driver's-side guidance line.
The guidance line should appear directly on top of the kerb, driveway or parking stall line.

w

Camera 1

< 2

=~ “"""?’H

= \“‘“

5 Use the arrows in the centre of the screen to move the coloured distance guidance lines up or down.

The red guidance line should be aligned with the rearmost part of your vehicle. This could be the rear
bumper, a trailer hitch or another object protruding from the rear of the vehicle.

6 Reposition the vehicle with the passenger side closely aligned to a kerb, driveway or parking stall lines and
use the arrows to align the white, passenger-side guidance line.

The guidance lines should be symmetrical.

Viewing Previous Routes and Destinations

Before you can use this feature, you must enable the travel history feature (Device and privacy settings,
page 39).
You can view your previous routes and places where you have stopped on the map.

Select B > Trip History.
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Settings

Map and vehicle settings

Select &¥ > Map Display.

Map Vehicle Icon: sets the vehicle icon that represents your position on the map.

Driving Map View: sets the perspective on the map.

Map Detail: sets the level of detail on the map. More detail may cause the map to be drawn more slowly.
Map Theme: changes the colour of the map data.

Map Layers: sets the data that appears on the map page (Customising the map layers, page 23).

Auto Zoom: automatically selects the zoom level for optimal use of your map. When disabled, you must zoom
in or out manually.

myMaps: sets which installed maps the device uses.

Enabling maps

You can enable map products installed on your device.

TIP: to purchase additional map products, go to garmin.com/maps.
1 Select f¥ > Map Display > myMaps.

2 Select a map.

Navigation settings

Select 'Q' > Navigation.

Calculation Mode: sets the route calculation method.

Avoidances: sets road features to avoid on a route.

Custom Avoidances: allows you to avoid specific roads or areas.

Tolls and Fees: sets preferences for avoiding toll roads and toll stickers.
NOTE: this feature is not available in all areas.

Environmental Zones: sets the avoidance preferences for areas with environmental or emissions restrictions
that may apply to your vehicle.

Restricted Mode: disables all functions that require significant operator attention.
GPS Simulator: stops the device from receiving a GPS signal and saves battery power.

Calculation Mode Settings

Select {F > Navigation > Calculation Mode.

The route calculation is based on road speeds and vehicle acceleration data for a given route.
Faster Time: calculates routes that are faster to drive but can be longer in distance.

Straight Line: calculates a direct line from your location to your destination.

Setting a simulated location

If you are indoors or not receiving satellite signals, you can use the GPS simulator to plan routes from a
simulated location.

1 Select 'Q' > Navigation > GPS Simulator.
2 From the main menu, select View Map.
3 Tap the map twice to select an area.
The address of the location appears at the bottom of the screen.
4 Select the location description.
5 Select Set Location.
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Wireless network settings

The wireless network settings allow you to manage Wi-Fi networks, paired Bluetooth devices and Bluetooth
features.

Select 'Q' > Wireless Networks.
Bluetooth: enables Bluetooth wireless technology.

Paired Device Name: the names of paired Bluetooth devices appear in the menu. You can select a device name
to change Bluetooth feature settings for that device.

Search for Devices: searches for nearby Bluetooth devices.

Friendly Name: allows you to enter a friendly name that identifies your device on other devices with Bluetooth
wireless technology.

Wi-Fi: enables the Wi-Fi radio.
Saved Networks: allows you to edit or remove saved networks.
Search for Networks: searches for nearby Wi-Fi networks (Connecting to a Wi-Fi Network, page 41).

Driver Assistance Settings
Select 'Q' > Driver Assistance.

Driver Alerts: allows you to enable or disable alerts for upcoming zones or road conditions (Driver awareness
features and alerts, page 4).

Speeding Alert: alerts you when you are exceeding the speed limit.

Reduced Speed Tone: alerts you when the speed limit decreases.

Route Preview: shows a preview of the major roads in your route when you start navigation.
Proximity Alerts: alerts you when you approach speed cameras or red light cameras.

Proximity alerts settings

NOTE: you must have custom points of interest (POls) loaded for proximity points alerts to display.
NOTE: this feature is not available in all areas.

Select 'Q' > Driver Assistance > Proximity Alerts.

Audio: sets the style of alert that plays when you approach proximity points.

Alerts: sets the type of proximity points for which alerts are played.

Display settings
Select &¥ > Display.

Colour Mode: allows you to select day or night colour mode. If you select the Auto option, the device
automatically switches to day or night colours based on the time of day.

Brightness: allows you to adjust the display brightness.

Display Timeout: allows you to set the amount of idle time before your device enters sleep mode while using
battery power.

Screenshot: allows you to take a picture of the device screen. Screenshots are saved in the Screenshot folder
of the device storage.

Traffic Settings
From the main menu, select Q‘ > Traffic.
Traffic: enables traffic.

Current Provider: sets the traffic provider to use for traffic data. The Auto option selects the best available
traffic data automatically.

Subscriptions: lists the current traffic subscriptions.

Optimise Route: enables the device to use optimised alternative routes automatically or upon request (Avoiding
traffic delays on your route, page 18).
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Units and time settings

To open the Units and Time settings page, from the main menu, select L¥ > Units & Time.
Current Time: sets the device time.

Time Format: allows you to select a 12-hour, 24-hour or UTC display time.

Units: sets the unit of measure used for distances.

Position Format: sets the co-ordinate format and datum used for geographical co-ordinates.

Setting the Time

1 From the main menu, select the time.

2 Select an option:
+ To set the time automatically using GPS information, select Automatic.
+ To set the time manually, drag the numbers up or down.

Language and Keyboard Settings

To open the Language and Keyboard settings, from the main menu, select > Language & Keyboard.
Voice Language: sets the language for voice prompts.

Text Language: sets all on-screen text to the selected language.

NOTE: changing the text language does not change the language of user-entered data or map data, such as
street names.

Keyboard Language: enables keyboard languages.

Device and privacy settings
Select 'Q > Device.

About: displays the software version number, the unit ID number and information on several other software
features.

Regulatory: displays regulatory markings and information.
EULAs: displays the end-user licence agreements.
NOTE: you need this information when you update the system software or purchase additional map data.
Software Licences: displays software licensing information.
Device Data Reporting: shares anonymous data to improve the device.

Travel History: allows the device to store a record of the places you go. This allows you to view the trip log, use
the Trip History feature and use myTrends suggested routes.

Reset: allows you to clear your travel history, reset settings or delete all user data.

Resetting Data and Settings

The device offers several options for deleting your user data and resetting all settings to the factory default
values.

1 Select 'Q' > Device > Reset.
2 Select an option:
+ To clear your travel history, select Clear Travel History.

This option deletes all records of the places you have travelled. It does not delete saved locations or
installed maps.

+ Toreset all settings to the factory default values, select Reset Default Settings.
This option does not delete any user data.

+ To delete all user data and reset all settings to the factory default values, select Delete Data and Reset
Settings.

This option deletes all user data, including your saved locations, recently found locations and travel
history. Installed maps are not deleted.
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Device information

Viewing E-label Regulatory and Compliance Information
1 From the settings menu, swipe to the bottom of the menu.

2 Select Device > Regulatory.

Specifications

Operating temperature range From -20° to 55°C (from -4° to 131°F)
Charging temperature range From 0° to 45°C (from 32° to 113°F)

Radio frequency/protocol 2.4 GHz @ 13 dBm maximum

Vehicle power using the included vehicle power cable. AC power using an

Power input optional accessory (for home and office use only).
Battery type Rechargeable lithium-ion
Charging the Device

NOTE: this Class Ill product shall be powered by an LPS power supply.
You can charge the battery in the device using any of these methods.
Connect the device to vehicle power.
Connect the device to an optional power adapter accessory, such as a wall power adapter.

You can purchase an approved Garmin AC-DC adapter suitable for home or office use from a Garmin dealer
or www.garmin.com. The device may charge slowly when connected to a third-party adapter.

Device maintenance

Garmin Support Centre

Go to support.garmin.com for help and information, such as product manuals, frequently asked questions,
videos and customer support.

Map and Software Updates
For the best navigation experience, you should keep the maps and software on your device up to date.

Map updates provide the newest available changes to roads and locations in the maps used by your device.
Keeping maps up to date helps your device find recently added locations and calculate more accurate routes.
Map updates are large and may take several hours to complete.

Software updates provide changes and improvements to the device features and operation. Software updates
are small and take a few minutes to complete.

You can update your device using two methods.
You can connect the device to a Wi-Fi network to update directly on the device (recommended). This option
allows you to update your device conveniently without connecting it to a computer.
You can connect the device to a computer and update it using the Garmin Express application (garmin.com
/express).
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Connecting to a Wi-Fi Network

The first time you turn on the device, it prompts you to connect to a Wi-Fi network and register your device. You
can also connect to a Wi-Fi network using the settings menu.

1 Select 'Q' > Wireless Networks.
2 If necessary, select Wi-Fi to enable Wi-Fi technology.
3 Select Search for Networks.
The device displays a list of nearby Wi-Fi networks.
4 Select a network.
5 If necessary, enter the password for the network, and select Done.

The device connects to the network, and the network is added to the list of saved networks. The device
reconnects to this network automatically when it is within range.

Updating Maps and Software Using a Wi-Fi Network

NOTICE

Map and software updates may require the device to download large files. Regular data limits or charges from
your Internet service provider apply. Contact your Internet service provider for more information about data
limits or charges.

You can update the maps and software by connecting your device to a Wi-Fi network that provides access to
the Internet. This allows you to keep your device up to date without connecting it to a computer.

1 Connect the device to a Wi-Fi network (Connecting to a Wi-Fi Network, page 41).

While connected to a Wi-Fi network, the device checks for available updates. When an update is available,
@ appears on the Q icon in the main menu.

2 Select 'Q' > Updates.

The device checks for available updates. When an update is available, Update Available appears below Map
or Software.

3 Select an option:
To install all available updates, select Install All.
+ Toinstall only map updates, select Map > Install All.
To install only software updates, select Software > Install All.
4 Read the licence agreements, and select Accept All to accept the agreements.

NOTE: if you do not agree with the licence terms, you can select Reject. This stops the update process. You
cannot install updates until you accept the licence agreements.

5 Using the included USB cable, connect the device to external power and select Continue (Charging the
Device, page 40).
For the best results, a USB wall charger that provides at least 1 A power output is recommended. Many
USB power adapters for smartphones, tablets, or portable media devices may be compatible.

6 Keep the device connected to external power and within range of the Wi-Fi network until the update process
is complete.

TIP: if a map update is interrupted or cancelled before it completes, your device may be missing map data. To
repair missing map data, you must update the maps again using either Wi-Fi or Garmin Express.
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Updating Maps and Software with Garmin Express

You can use the Garmin Express application to download and install the latest map and software updates for
your device.

1

2
3

If you do not have the Garmin Express application installed on your computer, go to garmin.com/express
and follow the on-screen instructions to install it (Installing Garmin Express, page 43).

Open the @ Garmin Express application.
Connect your device to your computer using a mini-USB cable.

The small end of the cable connects to the mini-USB port M on your CamperVan device and the large end
connects to an available USB port on your computer.

When your CamperVan device prompts you to enter file transfer mode, select Yes.
In the Garmin Express application, click Add a Device.
The Garmin Express application searches for your device and displays the device name and serial number.

Click Add Device and follow the on-screen instructions to add your device to the Garmin Express
application.

When setup is complete, the Garmin Express application displays the updates available for your device.

Updates Available

Last Checked: Just Now C

Estimated Install Time: 1 hour and 18 minutes
View Details

Select an option:
+ Toinstall all available updates, click Install All.
+ Toinstall a specific update, click View Details and click Install next to the update you want.

The Garmin Express application downloads and installs the updates onto your device. Map updates are very
large and this process may take a long time on slower internet connections.

NOTE: if a map update is too large for the internal storage of the device, the software may prompt you to
install a microSD°® card in your device to add storage space (Installing a memory card for maps and data,
page 45).

Follow the on-screen instructions during the update process to finish installing updates.

For example, during the update process, the Garmin Express application may instruct you to disconnect and
reconnect your device.
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Installing Garmin Express

The Garmin Express application is available for Windows® and Mac® computers.
1 On your computer, go to garmin.com/express.

2 Select an option:

To view the system requirements and verify the Garmin Express application is compatible with your
computer, select System Requirements.

+ Toinstall on a Windows computer, select Download for Windows.
To install on a Mac computer, select Download for Mac.
3 Open the downloaded file, and follow the on-screen instructions to complete the installation.

Device Care

NOTICE

Avoid dropping your device.

Do not store the device where prolonged exposure to extreme temperatures can occur, as it can cause
permanent damage.

Never use a hard or sharp object to operate the touchscreen as this may result in damage.
Do not expose the device to water.

Cleaning the outer casing

NOTICE

Avoid chemical cleaners and solvents that can damage plastic components.

1 Clean the outer casing of the device (not the touchscreen) using a cloth dampened with a mild detergent
solution.

2 Wipe the device dry.

Cleaning the Touchscreen

1 Use a soft, clean, lint-free cloth.

2 If necessary, lightly dampen the cloth with water.

3 If using a dampened cloth, turn off the device and disconnect the device from the power.
4 Gently wipe the screen with the cloth.

Avoiding theft

+ Remove the device and mount from sight when not in use.

+ Remove the residue left on the windscreen by the suction cup.

Do not keep your unit in the glove compartment.

+ Register your device using the Garmin Express software (garmin.com/express).

Restarting the Device
You can restart your device if it stops functioning.
Hold the power key for 12 seconds.

Removing the Device, Mount and Suction Cup

Removing the Device from the Mount
1 Press the release tab or button on the mount.
2 Tilt the bottom of the device upward, and lift the device from the mount.
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Removing the Device from the Mount
1 Grip the device by the top and bottom.
2 Pull the bottom edge of the device towards you until it releases from the magnet.
Pulling the device straight towards you may cause the mount to release from the suction cup.

Removing the Mount from the Suction Cup
1 Turn the device mount to the right or left.
2 Apply pressure until the socket on the mount releases the ball on the suction cup.

Removing the Suction Cup from the Windscreen
1 Flip the lever on the suction cup towards you.
2 Pull the tab on the suction cup towards you.

Troubleshooting

The suction cup will not stay on my windscreen

1 Clean the suction cup and windscreen with surgical spirit.

2 Dry with a clean, dry cloth.

3 Mount the suction cup (Mounting and powering the CamperVan device in your vehicle, page 2).

My device is not acquiring satellite signals
Verify the GPS simulator is turned off (Navigation settings, page 37).
Take your device out of car parks and away from tall buildings and trees.
Remain stationary for several minutes.

The device does not charge in my vehicle
+ Verify that the vehicle is turned on and is supplying power to the power outlet.

+ Verify that the interior temperature of the vehicle is within the charging temperature range indicated in the
specifications.

In the vehicle fuse box, verify that the fuse for the vehicle power outlet is not broken.

My battery does not stay charged for very long
Decrease the screen brightness (Display settings, page 38).
Shorten the display timeout (Display settings, page 38).
Decrease the volume (Adjusting the volume, page 3).
Turn off the Wi-Fi radio when it is not in use (Wireless network settings, page 38).
Put the device in power saving mode when not in use (Turning the device on or off, page 2).
Keep your device away from extreme temperatures.
Do not leave your device in direct sunlight.
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My device does not connect to my phone
- Select & > Wireless Networks.
The Bluetooth option must be enabled.
Enable Bluetooth wireless technology on your phone and bring your phone within 10 m (33 ft.) of the device.
Verify your phone is compatible.
Go to www.garmin.com/bluetooth for more information.
Complete the pairing process again.

To repeat the pairing process, you must unpair your phone and device (Deleting a paired phone, page 28) and
complete the pairing process (Live services, traffic and smartphone features, page 23).

Appendix

Installing a memory card for maps and data

You can install a memory card to increase the storage space for maps and other data on your device. You can
purchase memory cards from an electronics supplier, or go to www.garmin.com/maps to purchase a memory
card with pre-loaded Garmin mapping software. The device supports microSD memory cards from 4 to 32 GB.

1 Locate the map and data memory card slot on your device (CamperVan device overview, page 1).
2 Insert a memory card into the slot.
3 Pressitin until it clicks.

Data management
The device has a memory card slot for additional data storage.
NOTE: the device is compatible with Windows 7 and newer, and Mac OS 10.7 and newer.

About memory cards

You can purchase memory cards from an electronics supplier, or purchase pre-loaded Garmin mapping
software (www.garmin.com). Memory cards can be used to store files such as maps and custom POls.

Connecting the Device to Your Computer

You can connect the device to your computer using a USB cable.

1 Plug the small end of the USB cable into the port on the device.

2 Plug the larger end of the USB cable into a port on your computer.

3 When your CamperVan device prompts you to enter file transfer mode, select Yes.
A picture of your device connected to a computer appears on the device screen.

Depending on your computer operating system, the device appears as either a portable device, a removable
drive, or a removable volume.

Transferring data from your computer
1 Connect the device to your computer (Connecting the Device to Your Computer, page 45).

Depending on your computer operating system, the device appears as either a portable device, a removable
drive or a removable volume.

On your computer, open the file browser.

Select a file.

Select Edit > Copy.

Browse to a folder on the device.

NOTE: for a removable drive or volume, you should not place files in the Garmin folder.
6 Select Edit > Paste.

ga h~ WDN
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Disconnecting the USB cable

If your device is connected to your computer as a removable drive or volume, you must safely disconnect your
device from your computer to avoid data loss. If your device is connected to your Windows computer as a
portable device, it is not necessary to safely disconnect the device.

1 Complete an action:

For Windows computers, select the Safely Remove Hardware icon in the system tray and select your
device.

For Apple” computers, select the device, and select File > Eject.
2 Disconnect the cable from your computer.

Viewing GPS signal status

Hold gl for three seconds.

Purchasing additional maps

1 Go to your device product page at garmin.com.
2 Click the Maps tab.

3 Follow the on-screen instructions.

Purchasing accessories
Optional accessories are available at garmin.com or from your Garmin dealer.
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